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GETTING STARTED WITH EXCEL 

What Excel does 

1. Make calculations such as numeric, logical and text calculations. 

2. Perform data analysis: Excel is used to convert raw data into useful 

information for decision makers. 

Structure of Excel: Cells, Worksheets, Sheet Tabs and Workbooks 

 Columns are represented by letters 
 Rows are represented by numbers 

 A cell is the intersection of a column and a row = name or address like A5 
or A1. 

 Worksheet = sheet = all the cells. 

 Sheet Tab = Name of worksheet. Workbook = All the sheets = file. 
 Navigation of sheets is done using the following: 

1.   Ctrl + PageDown =expose next sheet to right. 

2.   Ctrl + PageUp =expose next sheet to left. 

3.   Right-click sheet navigation arrows to get a pop-up for sheet names. 

Keyboard Shortcuts are efficient because they help you to accomplish tasks 

quickly. 

Ctrl keyboards are keys you “hold” together: 

1.   Ctrl + Arrow: jumps to the bottom of the "Current Region", which 

means it jumps to the last cell that has data, right before the first empty cell. 

2.   Ctrl + Home = Jump to cell A1. 

3.   Ctrl + End = Go to last cell used. 

4.   Ctrl + Shift + Arrow = Highlight column (Current Region). 

Current Region is defined as all the data up to the first empty cell. 

5.   SUM: Alt + = 

6.   Ctrl + Backspace = Jump back to Active Cell. 

7.   Ctrl + 1 = Format Cells dialog box, or in a chart it opens Format Chart 

Element task Pane. 

 8.   Ctrl + Z = Undo, Ctrl + Y = Undo the Undo, Ctrl + C = Copy, Ctrl + V = 

Paste, Ctrl + X = Cut.  
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Alt keyboards are keys that you hit in succession: Page Setup: Alt, P, S, P 

Put "things" (formulas, text, and numbers) in cell with: 

1.   ENTER = Put thing in cell and move selected cell DOWN. 

2.   CTRL + ENTER = Put thing in cell and keep cell selected. 

3.   TAB = Put thing in cell and move selected cell RIGHT. 

4.   SHIFT + ENTER = Put thing in cell and move selected cell UP. 

5.   SHIFT + TAB = Put thing in cell and move selected cell LEFT. 

 

Data Analysis and Business Intelligence terms 
 

Data Analysis = convert raw data into useful information for decision makers. 

Business Intelligence = convert raw data into useful/actionable information 

(often times in the form of a dashboard) for decision makers in a business 

situation. 

Raw Data = data in its smallest form that allows Excel Data Analysis features 

and Excel data analysis techniques to work. 

Proper Data Set = Proper Table Format = Field Names in first row and Records 

in rows. 

Clean Raw Data = Fix unusable raw data so that it can be used to perform data 

analysis. 

Examples: 

 Remove unwanted charters. 

 Add needed characters. 
 Split data apart into desired data. 

 Join data together to get desired data. 

vi.   Transform Data Sets = Fix unusable data set so that it can be used to 

perform data analysis. 

Examples: 

 Filter, combine, merge, append or unpivot data sets. 

 Add, remove or filter columns in data sets. 

vii.  Import Data = import data from external sources (single or multiple 

sources) into Excel or Power Pivot’s Data Model; optimally, the import will allow 
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refreshes so that when source data changes the report output resulting from the 

import action will update reflecting the changes in the source data. 

viii. Goal of Data Analysis and Business Intelligence: Create useful, 

updateable, actionable information for decision makers. 

8)  Excel Proper Data Sets, Data Types, Alignment and the Excel Table feature: 

Proper Data Set and Proper Table Format are synonyms. 

The following Excel features do not work properly unless the raw data is stored 

in a proper Data Set: Sorting, Filtering, Advanced Filter, D Functions, 
PivotTables, Excel Table feature, Power Query, Power Pivot and Power BI 

Desktop. 

1.   Definition of Proper Data Set in Excel: 

 Field names in first row. 

 Records in subsequent rows. 
 Empty cells, Excel Row, or Column Headers must surround data 

set.  

 Data Types and Default Alignment in Excel 

2.   Data Types and Default Alignment in Excel 

 Numbers are aligned right.  

 Text values are aligned left. 
 Boolean Values (TRUE or FALSE) are aligned center and ALL CAPS.  

 Error Values are aligned center. 

 Empty Cells. 

3.   The Default Alignment in Excel gives a visual cue of what type of data it is. 

If Dates, Times or Numbers are aligned left and are considered text your 

formulas and other Excel features may not work as intended. Example: SUM 

function cannot add a column of Text Numbers. 

Reasons that Dates, Times or Numbers are aligned left and are considered Text: 

1.   Often times Dates, Times or Numbers exported from databases or text files 

are considered text. 

2.   If you apply the Text Number Format. 

3.   Using a lead apostrophe before the Date or Time or Number. 

4.   Miss typing a date or time or number (US system): 

 15/2/2016 (there is no 15th month). 
 8:00AM (no space between time and AM).  
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 20.56 (too many decimals). 

 Rule for when to manually change the alignment: 

1.   Only change the alignment when you are preparing the final report and the 

data will not be used by formulas or features. 

 

2.   Do NOT change alignment for raw data that will be used by formulas or 

other features. 
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Excel Table feature 

1.   What it does: 

i. The Excel Table is considered a “database table” which means it has dynamic 

ranges that allow you to add or remove new records or columns to the table and 
all Formulas, Charts, PivotTables, Power Queries and Power Pivot Data Models 

will automatically update (PivotTables, Power Queries and Power Pivot Data 

Models require you to click the Refresh button). 

ii.    Adds formatting to the entire table. 

iii.   Adds Sorting and Filter buttons to each field (at the top of each column). 

2.   How to convert Proper Data Set to an Excel Table: 

i.     With a single cell selected in the Proper Data Set: 

1.   Insert Ribbon Tab, Table group, Table button 

2.   Keyboard ===> C t r l  + T 

3.   How to name your Table: 

i.     With a single cell in the Excel Table: 

1.   Table Tools Ribbon Design Tab, Properties group, Table Name Textbox. 

2.   Keyboard: Alt, J, T, A 

4.   When you highlight a range from an Excel Table in your formula or a dialog 

box, the range shows up with the Table Name and Field Name: 

Example: if the Table Name is Transactions and the Field Name is Sales the 

range looks like this: 

     ProdSales[Sales] 

 Table names appear as the actual name: ProdSales.  

 Field names are in Square Brackets: [Sales]. 

5.   To add new records to a table: 

 Type new record in first row below table.  

 In last cell in last record in table, hit Tab. 

6.   To convert an Excel Table back to a non-Excel Table: 

 Right-click, Table, Convert to Range. 

9)  Number Formatting is a Façade: 
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i. Number Formatting can display numbers on the surface of the cells that 
can be different from the underlying numbers that sit in the cells. 

ii. Formulas make their calculation on the actual numbers in the cells, not 
the numbers that are displayed on the surface of the cells. 

iii. I f  you are required to round your numbers, like for invoices, payroll, 
accounting, use the ROUND function (see section later in this document 

about rounding).  

Remember: 

1.   “Formulas can’t see Number Formatting”. 

2.   What you see on the surface of the spreadsheet is not always, what is in 

the cell. 

v.    Examples of Number Formatting: 

1.   General Number Formatting: 

i.     General Number Formatting = What you see is what is in the cell. 

ii.    If you apply General Number Formatting, it will wipe away all of the 

previously applied 

Number Formatting to reveal what number actually sits in the cell. 

1.   Applying General Number Formatting ERASES all previously applied 

Number Formatting. 

iii.   General Number Formatting is the default Number Formatting on all cells. 

iv.    Ctrl + Shift + ~ ( ` ) = General Number Formatting Keyboard. 

2.   Decreasing Decimal Number Format: 

i.    Decreasing decimals does not remove underlying decimals, but rather, it 
displays the number with fewer decimals than the actual number that sits in the 

cell. 

ii.    When you decrease decimals, the number appears as if it has been 

rounded, but it is 

not rounded. If you have invoices, payroll and other numbers that require 
rounding, you must use the ROUND function to round the numbers in order to 

get the correct answer. 

3.   Accounting Number Format: 

i.     Fixed dollar sign (left edge of cell).  

ii.    Negatives are in parenthesis. 
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iii.   Zeros are dashes. 

iv.   Decimals always line up. 

v. When you use Accounting Number Format it may hide decimals by 

displaying fewer decimals than are actually in the cell. This may lead to formula 
errors due to fact the formula calculates on the underlying number and not the 

displayed number. 

4.   Currency: 

i.     Floating dollar sign. 

ii.    You choose how to show negatives.  

iii.   Zeros are zeros. 

iv.   Decimals usually line up. 

v.   When you use Currency Number Format it may hide decimals by displaying 

fewer decimals than are actually in the cell. This may lead to formula errors due 
to fact the formula calculates on the underlying number and not the displayed 

number. 

5.   Date Number Format: 

i. Enter dates with forward slashes (there are other methods also) such as: 

3/30/2016. 

ii. Under the Date Number Format is a Serial Number that represents the 

number of days since December 31, 1899. 

1.   Examples: 

Jan 1, 1900 = 1 

Jan 2, 1900 = 2 

Oct 30, 2013 = 41577 

Mar 30 = 42459  

iii.   Some Date Math Formulas: 

1.   =End Date – Start Date = Number of Days Between Two Dates (Number 

of days an invoice is late). 

2.   =End Date – Start Date + 1= Number of Days Between Two Dates 

Including the 

Start Date (Number of days for a project that includes the start date). 
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3.   =Loan Issue Date + Number of Days Loan Outstanding = Maturity 

Date. iv.   Date/Time Keyboards: 

1.   Ctrl + ; = Keyboard for hardcoding today's date. 

2.   Ctrl + Shift + ; = Keyboard for hardcoding current time. 

6.   Time Number Format: 

i.    Enter time as hour, colon, minutes, colon, seconds, then a space, and AM 

or PM (there are other methods also) such as: 8:00 AM. 

ii.   Under the Time Number Format is a serial number that represents the 

proportion of one 24-hour day. 

1.   Examples: 

8:00 AM = 8/24 = 1/3 = 0.333333333333333 

12:00 PM = 12/24 = 1/2 = 0.5 

3:00 PM = (12 + 3)/24 = 15/24 = 5/8 = 0.625  

iii.   Some Time Math Formulas: 

1.   =(End Time – Start Time)*24 = Hours worked in a non-night-shift day. 

2.   =MOD(End Time – Start Time,1)*24 = Hours worked in a day or night-

shift day. 

iv.   Date/Time Keyboards: 

1.   Ctrl + ; = Keyboard for hardcoding today's date. 

2.   Ctrl + Shift + ; = Keyboard for hardcoding current time. 

7.   Percentage Number Formatting: 

i.     What is a percentage? 

1.   How many parts out of 100? 

i.   If the tax rate is 9.95%, this means that you must pay 9.95 pennies out of 

every 100 pennies (or one dollar). 

ii.    What Percentage Number Format does: 

1.   For the number 0.03, Percentage Number Formatting displays the number 

with: 

i.   The decimal slid two positions to the right and 

ii.   A percentage sign. 
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iii.   0.03 becomes 3.00% 

2.   For a tax rate of 1.45%, you have to remember that the underlying 

number is 0.0145. 

8.   Custom Number Format: 

i.     There are four sections to Custom Number Formatting, each separated by 

a semi-colon: 

<POSITIVE>;<NEGATIVE>;<ZERO>;<TEXT> 

ii.   In general, in this class we will learn some basic code for Custom Number 

Formatting and rely on looking up the code when we need it. 

iii.   We will learn a few basic Custom Number Formatting types: 

1.   Date. 

2.   Time. 

3.   Percentage 

4.   Significant and insignificant decimals. 
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10) Style Formatting allows you to present information in an effect way. 

i.     Style Formatting involves formatting such as: 

1.   Bold. 

2.   Fill Color. 

3.   Font Color. 

4.   Borders Alignment. 

5.   Font Size. 

6.   Font Type. 

7.   Word Wrap 

i.     Alt + Enter = Add Manual Line Break (Word Wrap) 

ii.    Guidelines for Style Formatting: 

1.   Use the minimum amount to effectively deliver the message. 

2.   Be consistent. 

3.   All numbers should have same number of digits. 

4.   Units must be indicated either with Number Formatting or Labels. iii.   Two 

Schools of Thought for Stylistic Formatting: 

1.   Minimalism School says: 

i.     Field names or column headers should be bold.  

ii.    Use Number formatting sparingly. 

iii.   Don’t use alignment. 

iv.   The default gray lines in the spreadsheet are the only borders you need.  

v.    Sometimes red is used to indicate importance. 

2.   More Than Minimal School says: 

i.     Field names or column headers can have Fill Color and Font Color, but be 

consistent. 

ii.    Font Color and Fill Color must have a large value difference so that it is easy to 

read: 

1.   Dark Blue Fill Color and White Font Color have a large value difference. 

2.   Red Fill Color and Black Font Color do NOT have a large value difference.  



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 13 of 156 

 

iii.   Use Number Formatting Consistently. 

iv.   Black Borders can be okay for tables of data. 

v.    Use similar color schemes across tables, charts, PivotTable, Slicers and other 

objects. 

iv.   Cell Styles 

1.   Allow you to save a set of Stylistic & Number Formatting and use it as often as 

you need. 

2.   Add New Cell Style: 

i.     Add style to a cell 

ii.    Go to Styles group in the Home Ribbon and click on the Cell Styles dropdown 

arrow or 

“More button” and click on New Style. This opens the Styles dialog box. iii.   Name 

the Style 

iv.   When in the Style dialog box, you can use the Format button to add more 

styles if you want 

3.   To use the Cell Style: select cells and apply new style from the Style group in 

the Home Ribbon 

Tab.
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11) Page Setup allows you to print information in an effect way 

i.     Page Setup dialog box 

1.   Open Page Setup dialog box keyboard = Alt, P, S, P 

2.   Page Setup dialog box i. Page tab: 

1.   Orientation: 

i.   Landscape when the table is wider than it is tall. ii.   Portrait when it is 

taller than it is wide. 

2. Scaling: you can shrink or enlarge the how the information will look when 

it prints out. 

3. Fit to: 

i. Allows you to take a table that is slight bigger than the page and shrink it 

to fit on the page. 

ii. If you type “1” for pages wide” and leave the text box empty (hit delete 

key) for “pages tall”, the information will always fit to one page wide, but it 
will print out as many pages tall as you need. This is great if you have an 

expanding table, or you don’t know how many pages tall the information is. 

Margins tab: Set margins on edge of each page.  

Header/Footer tab: 

1.   Header 3 sections: 

i.   Preview: gives you a preview. 

ii.   Built-in: select from drop down list. 

iii.   Custom Header: Allows you to type header or select from a number of 

different options (buttons). 

2.   Footer 3 sections: 

i.   Preview: gives you a preview. 

ii.   Built-in: select from drop down list. 
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iii.   Custom Footer: Allows you to type footer or select from a number of 

different options (buttons). 

iv.   Sheet tab: 

1.   Set Print Area: Select just the range you want to print. This is great 

when you want to exclude data and calculations that are not part of the final 

report. 

2.   Columns to repeat on Left: Prints the highlighted column on each page. 

This is great for large tables, like when you want to repeat names on the left 

of each page. 

3.   Rows to repeat at Top: Prints the highlighted row at the top of each 

page. This is great for large tables, like when you want to repeat field names 

at the top of each page. 

Develop Effective and Efficient Solutions in Excel 
 

i. Effective: Accomplish the stated goal. 

Examples: 

 Use COUNTIFS to count the correct number for how many Ford cars were sold. 
 Use the correct Number Format to display the same number as the underlying 

number in the cell. 

ii. Efficient: Accomplish the goal with the minimum number of resources and 

have the accomplished goal have the ability to adapt to future changes. 

Examples of tasks that accomplish the goal with the minimum number of 

resources (where the resource is time to create a solution) are: 

i. Use Mixed Cell References and the COUNTIFS function to build a cross 

tabulated table with a single formula rather than many formulas. 

ii. Use keyboard shortcuts to accomplish most tasks, rather than slower 

methods like using the Ribbon Tabs, Menus or scroll bars. 

3. Examples of tasks that accomplish the stated goal and have the ability to 

adapt to future changes are: 
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i. For a formula that calculates a tax deduction you must place the tax rate in 
a cell, label it and refer to the tax rate in the formula with a cell reference. In 

this way if the tax rate changes, it is easy to update it later. Hard coding 
formula inputs into formulas makes it time consuming and difficult to update 

the formula later (and is the #1 cause of spreadsheet error). Formulas like: 

=ROUND(A44*0.0765,2) are hugely inefficient and error prone. 

ii. Formula like =SUM(A1:A5) rather than =A1+A2+A3+A4+A5 will update if 

a row is inserted at row four. 

iii. Goal of Class: Develop Effective and Efficient Solutions in Excel for Making 

Calculations Performing Data Analysis 
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IMPORTING A FILE TO EXCEL 

Importing a text file 
 

1. Open a new workbook 

2. Select...DATA…. Get External Data…. From Text 

Figure 1: Importing the text file 

 

 

3. In the Import Text File dialogue, browse, select and import the products.txt 

file from the products sub-folder under the files folder. 

4. In the Text Import Wizard that pops up (See Figure 2: Text Import Wizard 

below) leave the default selection of file type selected since we are importing a 

tab delimited (separated) file. 

5. From the preview of the file being imported, you will also note that the file has 

headers. For that reason, please check the “My data has headers” check box 

as shown in (Figure 2: Text Import Wizard below) 

Figure 2: Text Import Wizard 
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6. Click Next 

7. In step 2 of the Wizard, (See Figure 3: Effect of selecting the right text), you 

will notice that Tab delimiter is checked by default. Please keep it checked 

since our delimiter is a tab 

Figure 3: Effect of selecting the right text delimiter 
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9. Click next 

10. In the last step of the wizard (See Figure 4: Defining field data formats 

below), we define the data formats for each field.
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Figure 4: Defining field data formats 

 

 

11. Click Finish 

We want the data to be imported starting at Cell A1. If A1 is not the selected 

cell, please change it by editing the contents of the box below to match what 

you see.
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12. Click OK 

We have just completed the procedure for importing a text file using Microsoft 

Excel. 
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WORKING WITH TEMPLATES 

Templates are worksheets that are already designed for you.  

 

When you use a template, all you have to do is replace the information in the 

worksheet with your own. They help you save oodles of time and keep your 

worksheets consistent. You can even edit the templates, or create your own 

and then use them again and again. 

Changing the default workbook template 

Whenever you open a blank workbook in Excel, you are opening a template -- one 

in which the margins, font, and themes were already defined. This is the default 

template. It is not as fancy as some of the templates you see pictured, but it's still 

a template. You can edit this template in the same way you would edit the fancier 

templates, then save it as a new template. 

To create a new template, open a workbook (or create a workbook) that you want 

to use as a template. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 5 of 156 

 

Everything you see or add to the workbook will be part of the template. 

When you have the workbook the way you want your template to be, click File, 

then Save As. 

Select the location to save the workbook to, then choose to save the workbook as 

an Excel Template. 

 

Now whenever you open the template, all you have to do is customize it for a new 

workbook, then save the new workbook. 

Choose the template that you want to use by clicking on it.  
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Click the Create button to create the template. 

We've chosen the Any Year Calendar template, and we clicked Create. 

Excel loads the template for you. 
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Searching for a Template 

Excel gives you a few ways to search for a template you want. At the top of the 

screen (File>New), you will see this: 

 

You can type in the kind of template you want. Let us say we want a calendar. 

Type in calendar. 
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Excel then searches its online database for a calendar template, then shows you 

the results: 

 

To the right, you'll see the category pane where you can search for a calendar 

template by category. Simply click on a category to see its calendars. 

Modifying a template 

Let's go back to our Calendar template that we showed earlier: 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 9 of 156 

 

 

Once you've opened a template, you can now make changes to it. You can change 

the font size, font color, etc. if you want, and you can also customize the data. 

To edit the data, click on a cell. It then selects the cell, as shown below. 
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Now simply type the data you want. 

We can also change the style of the template. 

Notice below that we've clicked on the cell that contains the month of April. While 

the cell is selected, you can also look in the Styles gallery to see the style applied 

to it. 
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You can modify the style to change the formatting. 

Click on any image in a template, and you'll see a bounding box appear around it: 

 

You can then cut or copy the image. 
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Opening an Existing Template 

Microsoft provides a number of templates to make your work easier. If you already 

have Excel open, you can view the templates by clicking the File tab, then going to 

New. You can then see the templates just as you did on the start screen. 

 

As you can see, the blank workbook template appears first, followed by a tour of 

Excel 2013/2016. After this, you can see all the templates. 

Choose the template that you want to use by clicking on it. 
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EFFICIENCY AND RISK 

Protecting individual cells 
 

In this topic, we look at how to lock individual cells in a Microsoft Excel worksheet. 

The procedure to use depends on whether you want the majority of the cells on the 

worksheet to remain locked or unlocked. 

 

NOTE: If you lock a cell and protect the worksheet, then you cannot type data 

into the cell, modify the data currently in the cell, or change other attributes of the 

cell (such as cell formatting). 

To unlock individual cells in an Excel worksheet, use either of the following 

procedures. 

 

To lock the majority of the cells on the worksheet: 

Select the cells that you want to remain unprotected. To select nonadjacent 

(noncontiguous) cells, hold down CTRL and click the cells that are to remain 

unprotected. 

1. Show the format cells dialog box by clicking the Expand button to the bottom 
right of the Font section of the Home ribbon, and then click Protection tab. 

2. Click to clear the Locked check box and click OK. 
3. Click the Review tab, and click Protect Sheet. Type a password if you want 

one, and then click OK. 

 

To leave the majority of the cells on the worksheet unlocked: 

Select the entire worksheet by clicking the Select All button (the gray rectangle in 

the upper-left corner of the worksheet where the row 1 and column A headings 

meet), or by pressing CTRL+A or CTRL+SHIFT+SPACEBAR. 

1. Show the format cells dialog box by clicking the Expand button to the bottom 

right of the Font section of the Home ribbon, and then click Protection tab. 

Click to clear the Locked check box and click OK. 
2. Select the cells that you want to protect. To select nonadjacent (noncontiguous) 

cells, hold down CTRL and click the cells that you want to protect. 

3. Return to the Format Cells dialog box, and then click the Protection tab. Click 

to select the Locked check box, and then click OK. 
4. Click the Review tab, and click Protect Sheet. Type a password, if you want 

one, and then click OK. 
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Protecting a worksheet 

Add protection to worksheets so that other people cannot edit them. You can lock 

cells or an entire worksheet. We saw in the previous topic how to lock individual 

cells. 

To protect a worksheet, go to the Review tab, and then click Protect Sheet in the 

Changes group. 

 

You can add a password that someone has to enter to be able to make changes. 

In the Allow All Users of This Worksheet To section, specify what other users CAN 

do to the worksheet. 

Click OK. 

Protecting a workbook 

Under the Review tab, click Protect Workbook in the Changes group. 
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Again, you can add a password. 

You can protect the workbook for structure or windows. Protecting it for windows 

prevents anyone from changing the size and position of the windows when the 

workbook is opened. Protecting it for structure prevents anyone from viewing 

worksheets that you have hidden; moving, deleting, hiding, or changing the names 

of worksheets; and inserting new worksheets or charts, moving or copying 

worksheets. 

If you want to change the look and feel of the tables used in the template, you can do that by 

selecting a table in the template, then using the Format as Table button. 
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You can add a password that someone has to enter to be able to make changes. 

In the Allow All Users of This Worksheet To section, specify what other users CAN do to the 

worksheet. 

Click OK. 

 

Sharing Workbooks 

You can easily share workbooks without having to send them via email as large 

attachments. To be able to share your workbooks with others for review or editing, 

click the File tab, then click Share. 

 

Now, choose how you would like to share the workbook. 

Invite People is cloud-based sharing. First, save your workbook to your SkyDrive, 

then invite the people who you want to be able to view it. 

Email allows you to send the file by email using your default email program. 
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You can choose to send it as an attachment, send it as a PDF, as an XPS – or even 

as a fax. 

You can save your workbook to a shared location, such as a company server, you 

can also send a link to the workbook by choosing Send a Link (above). 
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EXCEL HYPERLINKS 

Creating a Hyperlink 

A hyperlink is a link to a website or location on the Internet – or even your 

computer, if the person reading your spreadsheet has access to your computer 

files. To insert a hyperlink into a spreadsheet, go to the Insert tab, then the Links 

group. Click the Hyperlink button. You can also right click in the cell where you 

want to insert the link and select hyperlink. 

 

You will see this window: 

 

In the Text To Display field, enter in the text you want displayed in your 

spreadsheet. This will be the text people can click on to take them to the web page. 

It doesn't have to be a URL. You can type in the word "cow" if you want. 

Choose what you want to link to. We have chosen a place in the spreadsheet. 
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Click OK when you are finished. 

Embedding an object 

To embed an object into Excel, select a location, then click the Insert tab, then the 

Object button. 

 

The Object dialog box will open. 

 

As you can see, you can now choose an object to embed. We are going to scroll 

down and embed a WordPad document. 
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Click OK when you have chosen your object. 

We now have a WordPad spreadsheet open on top of our spreadsheet. If you look 

to the right of the WordPad document, you will notice a text box where your text 

will be placed. 

 

Start typing into the WordPad document. 
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When you are finished, click the File tab in the WordPad document. 

 

Select Exit and return to document. 

The object is now embedded. You can re-size, move, and even format the object. 
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Text Boxes 

Sometimes, you don't want to type in a cell. Perhaps you have a picture that you 

need to add a caption for, or you want to type instructions. For things like this, you 

create text boxes to enter in text. Text boxes can easily be moved, re-sized, and 

re-positioned (along with the text inside them) to make creating a layout easy. 

To create a text box, go to the Insert tab and find the Text box button in the Text 

group. 

 

Click the Text Box button. 

The cursor changes to a downward arrow over your spreadsheet. 

Simply click and drag to draw your text box. You do not have to draw it according 

to cells. In other words, you don't have to worry about starting at the top corner of 

one cell and dragging. You can put it wherever you want. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 23 of 156 

 

 

When you quit dragging and release your mouse, the cursor will appear in the text 

box. 

Enter your text. 

You can format the text in a text box the same way that you format a cell. 
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DATA VALIDATION 

1)   Data Validation means that you “validate that the correct data goes into the 

cell”. 

2)   Data Validation feature in in the Data Tools group in the Data Ribbon Tab: 

 

 

 

 

 

 

 

 

 Data Validation allows you to “pick from a list of rules to limit the type of data that 

can be entered into a cell.” 

 Caveat about adding Data Validation to a cell: 

1.   If incorrect data is in cells BEFORE you add Data Validation, when you add DV, it 

won't automatically tell you about the incorrect data. 

i. Unless you: Data menu, Data Tools group, Data Validation, "Circle invalid data". 

2.   If you Copy and Paste something into a cell that has a Data Validation Rule, the 

Copy and Paste action will overwrite the Data Validation.
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Data Validation Dialog Box 

1)   Keyboard for Data Validation dialog box: Alt, D, L 

2)   Data Validation dialog box looks like this: 

 

3)   Allow text box: 

 Whole Number: 

1.   Choose comparative operator 

2.   Set limits 

 Decimal: 

1.   Choose comparative operator 

2.   Set limits 

 List: 

1.   Values in "Source" text box can be: 

i.     Ranges of cells ii.    Defined Names 

iii.   Range from Excel Table 

iv.   Values typed in separated by commas 

 Date: 

1.   Choose comparative operator 

2.   Set limits 

 Time: 

1.   Choose comparative operator 

2.   Set limits 
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 Text length: 

1.   Choose comparative operator 

2.   Set limits 

 Custom: 

1.   Logical Formula that evaluates to TRUE (value allowed) or FALSE (value not 

allowed). 

4)   Input Message 

 Text that shows up if you click in the cell with DV 

5)   Error Alter 

 "Stop" means that you cannot violate the rule 

 "Warning" gives an option to adhere to or not adhere to the data validation 

 "Information" just gives information without enforcement of rule. 

 

Dependent drop down lists 
 

6)   INDIRECT function takes text that represents a reference and converts it 

back to a reference. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 27 of 156 

 

Cumulative list of keyboards used under data validation: 

1)   Esc Key: 

i. Closes Backstage View (like Print Preview).  

ii. Closes most dialog boxes. 

iii. If you are in Edit mode in a Cell, Esc will revert to what you had in the cell before 

you put the Cell in edit mode. 

2)   F2 Key = Puts formula in Edit Mode and shows the rainbow colored Range Finder. 

3)   SUM Function: Alt + = 

4)   Ctrl + Shift + Arrow = Highlight column (Current Region). 

5)   Ctrl + Backspace = Jumps back to Active Cell 

6)   Ctrl + Z = Undo. 

7)   Ctrl + Y = Undo the Undo. 

8)   Ctrl + C = Copy. 

9)   Ctrl + X = Cut. 

10) Ctrl + V = Paste. 

11) Ctrl + PageDown =expose next sheet to right. 

12) Ctrl + PageUp =expose next sheet to left. 

13) Ctrl + 1 = Format Cells dialog box, or in a chart it opens format chart element 

task pane. 

14) Ctrl + Arrow: jumps to the bottom of the "Current Region", which means it jumps 

to the last cell that has data, right before the first empty cell. 

15) Ctrl + Home = Go to Cell A1. 

16) Ctrl + End = Go to last cell used. 

17) Alt keyboards are keys that you hit in succession. Alt keyboards are keyboards you 

can teach yourself by hitting the Alt key and looking at the screen tips. 

i.     Create PivotTable dialog box: Alt, N, V 

ii.    Page Setup dialog box: Alt, P, S, P 

iii.   Keyboard to open Sort dialog box: Alt, D, S 
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18) ENTER = When you are in Edit Mode in a Cell, it will put thing in cell and move 

selected cell DOWN. 

19) CTRL + ENTER = When you are in Edit Mode in a Cell, it will put thing in cell and 

keep cell selected. 

20) TAB = When you are in Edit Mode in a Cell, it will put thing in cell and move 

selected cell RIGHT. 

21) SHIFT + ENTER = When you are in Edit Mode in a Cell, it will put thing in cell 

and move selected cell UP. 

22) SHIFT + TAB = When you are in Edit Mode in a Cell, it will put thing in cell and 

move selected cell LEFT. 

        23) Ctrl + T = Create Excel Table (with dynamic ranges) from a Proper Data Set.  

 Keyboard to name Excel Table: Alt, J, T, A 

 Tab = Enter Raw Data into an Excel Table. 

24) Ctrl + Shift + ~ ( ` ) = General Number Formatting Keyboard. 

25) Ctrl + ; = Keyboard for hardcoding today's date. 

26) Ctrl + Shift + ; = Keyboard for hardcoding current time. 

27) Arrow Key = If you are making a formula, Arrow key will “hunt” for Cell 

Reference. 

28) Ctrl + B = Bold the Font 

29) Ctrl + * (on Number Pad) or Ctrl + Shift + 8 = Highlight Current Table. 

30) Alt + Enter = Add Manual Line Break (Word Wrap) 

31) Ctrl + P = Print dialog Backstage View and Print Preview 

    32) F4 Key = If you are in Edit mode while making a formula AND your cursor is 
touching a particular Cell Reference, F4 key will toggle through the different Cell 

References: 

i.     A1 = Relative 

ii.    $A$1 = Absolute or “Locked”
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iii.   A$1 = Mixed with Row Locked (Relative as you copy across the columns 

AND Locked as you copy down the rows) 

iv.   $A1 = Mixed with Column Locked (Relative as you copy down the rows 

AND Locked as you across the columns) 

33) Ctrl + Shift + 4 = Apply Currency Number Formatting 

34) Tab key = When you are selecting a Function from the Function Drop-
down list, you can select the function that is highlighted in blue by using 

the Tab key. 

35) F9 Key = To evaluate just a single part of formula while you are in edit 

mode, highlight part of formula and hit the F9 key. 

i. If you are creating an Array Constant in your formula: Hit F9. 

ii. If you are evaluating the formula element just to see what that part of the 

formula looks like, REMEMBER: to Undo with Ctrl + Z. 

36) Alt, E, A, A = Clear All (Content and Formatting) 

37) Evaluate Formula One Step at a Time Keyboard: Alt, M, V 

38) Keyboard to open Sort dialog box: Alt, D, S 

39) Ctrl + Shift + L = Filter (or Alt, D, F, F) = Toggle key for Filter Drop-

down Arrows 

40) Ctrl + N = Open New File 

41) F12 = Save As (Change File Name, Location, File Type) 

42) Import Excel Table into Power Query Editor: Alt, A, P, T 

43) Ctrl + 1 (When Chart element in selected): Open Task Pane for Chart 

Element 

44) F4 Key = If you are in Edit mode while making a formula AND your 

cursor is touching a particular Cell Reference, F4 key will toggle through 

the different Cell References: 

i.     A1 = Relative 

ii.    $A$1 = Absolute or “Locked” 

    iii.   A$1 = Mixed with Row Locked (Relative as you copy across the 

columns AND Locked as you copy down the rows) 

    iv.   $A1 = Mixed with Column Locked (Relative as you copy down the 

rows AND Locked as you across the columns) 
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45) Keyboard to open Scenario Manager = Alt, T, E 

46) Ctrl + Tab = Toggle between Excel Workbook File Windows 

47) Ctrl + Shift + F3 = Create Names From Selection 

48) Ctrl + F3 = open Name Manager 

49) F3 = Paste Name or List of Names 

50) Alt + F4 = Close Active Window 

51) Window Key + Up Arrow = Maximize Active Window 

52) Ctrl + Shift + Enter = Keystroke to enter Array Formulas that: 

 Have a function argument that requires it, or  
 Whether or not you are entering the Resultant Array into multiple 

cells simultaneously. 

53) Ctrl + / = Highlight current Array 

 

  



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 31 of 156 

 

CONDITIONAL FORMATTING 

1)   Conditional Formatting for cells in a highlighted range requires a 

logical test that comes out TRUE or FALSE 

 TRUE = Cell gets Formatting. 

 FALSE = Cell NOT get Formatting. 

2)   Conditional Formatting can be applied to cells with: 

 Built-in features like: 
 Contains a value 

 Top 3 values 
 Above Average 

 Data Bars 
 Color Scales (Heat Map) 

 Icons 

Logical Formulas: 

1.   Highlight Row (Record) where cell contains a value. 

2.   Highlight Row (Record) where sales are below average. 

3.   Highlight Records that contain the top 3 values. 

4.   Format Whole Column Based on a condition. 

5.   Format with complex criteria (AND Logical Test). 

6.   Format with complex criteria (OR Logical Test). 

7.   Format Weekends and Holidays. 

8.   Format items NOT in List. 

 

To apply Conditional Formatting: 

1) Home Ribbon Tab, Styles group, Conditional Formatting button: 
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2)   Keyboards: 

 Keyboard for New Format Rule dialog box: Alt, H, L, N 
 Keyboard for Manage Rule dialog box: Alt, O, D 

 Keyboard to delete rule: Alt, O, D, D, Enter 

 Keyboard to get to “Format values where this formula is true”: Alt, H, L, 

N, PageDown, Tab 

 

Built-in features for Conditional Formatting 
 

Steps: 

1)   Highlight cells 

2)   Home Ribbon Tab, Styles group, Conditional Formatting button 

3)   Select Rule 

4)   Choose formatting 

 

Built-in Conditional Formatting Options: 
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Logical Formulas 
 

1)   Logical Formulas are formulas that evaluate to TRUE or FALSE 

2)   For Conditional Formatting: 

 Formatting is applied when the formula evaluates to: 

1.   TRUE 

2.   Any non-zero number 

 Formatting is NOT Applied when the formula evaluates to: 

1.   FALSE 

2.   Zero 

3.   Error 

3)   When you use Logical Formulas to apply Conditional Formatting: 

 Formula has to calculate in every cell in the range 

 Rule to minimize calculation time: 

1.   Choose formulas that calculate quickly. 

2.   Use Helper Cells for sub-calculations so that the Conditional Formatting Logical 

Formula 

don’t have to run the sub-calculation in every cell in the Conditional Formatting 

range. 

4)   Array Formulas work in the Conditional Formatting dialog box (without using Ctrl 
+ Shift + Enter), but should be avoided if overall spreadsheet calculation time is an 

issue. 

 

 

 

 

Steps in Creating Conditional Formatting with Formulas: 

1)   Highlight the range of cells. Make a metal note of which cell is the active cell in 

the highlighted range. (The active cell is the light-colored cell.) 
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2)   Open the Conditional Formatting Rules Manager dialog (from the Home Ribbon 
tab, select the Styles group and then select Manage Rules from the Conditional 

Formatting drop-down). 

3)   Open the New Formatting Rule dialog box (by clicking the New Rule button). 

4)   Select Use a Formula to Determine Which Cells to Format from the "Select a 

Rule Type" list. 

5)   Click the format values where this formula is true text box. 

6)   Create your formula from the point of view of the active cell in the highlighted 
range. That is, build the formula as if you were placing it into the active cell and 

then copying it down and over. Remember, whatever the conditional test is that you 

are creating must be evaluated for each cell to determine whether each cell in the 
range gets the formatting. So, even if the formula is not actually going into the 

active cell, the dialog box will copy it throughout the range in memory as if the 

formula were in the cells in the highlighted range. 

7)   Click the Format button and select any combination of formatting you want 

from the four tabs (Number, Font, Border, and Fill). 

8)   Click OK in the format cells dialog box. 

9) Click ok in the new formatting rule dialog box. 

10) Click ok in the conditional formatting rules manager dialog box.
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Conditional formatting is volatile: it recalculates often and can slow overall 

spreadsheet calculation time. 

1)   Conditional formatting is recalculated for cells that are visible on the screen 

 Large screens have more cells to calculate than small screens. 

 Zoomed out has more cells to calculate than zoomed in. 

 Scrolling up or down causes Conditional Formatting to recalculate. 

2)   Conditional formatting is recalculated when actions occur such as: 

 Entering a formula. 
 Inserting a column. 

 Recalculating with the F9 key. 

3)   Conditional Formatting created with Logical Formulas slows down calculation in 

two ways: 

1.   Recalculation (like scrolling or entering a formula) 

2.   Formula has to calculate before formatting is applied. 

4)   When you use Logical Formulas to apply Conditional Formatting: 

 Choose formulas that calculate quickly 
 Use Helper Cells for sub-calculations so that the Conditional formatting Logical 

Formula don’t have to run the sub-calculation in every cell in the Conditional 

Formatting range.
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Example 1: Built-in Feature: Cell Contains 

 

Visual Steps for using Built-in Conditional Formatting Feature 

Steps: 

1)   Highlight range and go to Home Ribbon Tab, Styles group, Conditional 

Formatting button, Highlight Cells 

Rule, Equal to: 

 

 

2)   Enter cell with criteria into Equals To dialog box: 

 

 

 

3)   You can change the default formatting by clicking “with” textbox and choosing 

“Custom Format”: 
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4)   Result: 
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Example 2: Logical Formula: Highlight Row (Record) where cell contains a value. 

Visual Steps for Conditional Formatting with a Formula. 

1)   Start by building Formula in cells to test the pattern of TRUEs and FALSEs: 

 

 

 

2)   Highlight entire range and make sure the active cell is in the upper corner. 

 

 

 

 

 

 

 

 

3)   Home Ribbon Tab, Styles group, 

Conditional Formatting button, 
select New Rule (keyboard: Alt, 

H, L, N) 
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4)   In the “New Formatting Rule” 
dialog box, select “Use a Formula to 

determine which cells to format” 
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5)   Create your Logical Formula in the “Format values where this formula is true” 

text box. 

 

6)   Be sure to click Format Button and add the formatting you would like. 

 

 

 

 

 

 

 

Example 3: Built-in Feature: Below Average 
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Example 4: Built-in Feature: Top 3 values 

 

 

 

Example 5: Logical Formula: Highlight Records that contain the top 3 values 

Note: 

LARGE Function does not have to calculate in every cell in the conditional 

formatting range. 
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The advantage of using a helper cell to calculate sub calculations is that when the 

spreadsheet recalculates, only one cell has to calculate the largest value.
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Example 6: Built-in Feature: Data Bars 

1)   Data Bars creates an “In-Cell Bar Chart”. 

 Max = Longest Bar. 

 Min = Shortest Bar. 

2)   Example: 
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Example 7: Built-in Feature: Color Scales (Heat Map) 

1)   Color Scale = Ranks number by color. 

2)   3 colors: 

 Red = bottom 1/3 of values, Darkest Red = Min. 

 White = middle 1/3 of values, White = Mid-point (Median). 

 Blue = top 1/3 values, Darkest Blue = Max. 

3)   Example: 
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Example 8: Built-in Feature: Icons 

 

1)   Icons = can divide numbers into 3, groups (Top, middle, bottom) 

2)   SIGN function delivers: 

 Delivers -1 when number is negative. 

 Delivers 0 when number is zero. 

 Delivers 1 when number is positive. 

3)   Example: 

 

Example 9: Logical Formula: Format the whole column based on a condition 
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Example 10: Logical Formula: Format with complex criteria (AND Logical Test) 

1)   AND Logical Test with AND function: 

 

 

Example 11: Logical Formula: Format with complex criteria (OR Logical Test) 

1)   OR Logical Test with MATCH function (Is Item in List?): 
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Example 12: Logical Formula: Format Weekends and Holidays 

 

1)   NETWORKDAYS.INTL function counts working days: 

 NETWORKDAYS.INTL(start_date , end_date , weekend , holidays) 

 weekend argument drop-down list: 

 

  

 

 Normally it will count the number of weekdays between a start and end date. But if 
you give it the same start and end date, the function can only deliver either a one (1), 

if it is a weekday, or zero (0), if it is a weekend or holiday. 

 

2)   Example: 
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ADVANCED EXCEL FUNCTIONS 

The IF function 

Applies To: Excel 2016 Excel 2013 Excel 2010 Excel 2007 Excel 
The IF function is one of the most popular functions in Excel, and it allows 

you to make logical comparisons between a value and what you expect. In 
its simplest form, the IF function says: 

 IF(Something is True, then do something, otherwise do something else) 

So an IF statement can have two results. The first result is if your 
comparison is True, the second if your comparison is False. 

Scenario: Budgeting and Expenditure 

=IF(B2>A2,"Under Budget", "Within Budget")) 

 

 

 

NESTING IF FUNCTIONS 

An IF function may have many other IF functions embedded 
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Assume three results in the above example: Under Budget, Within Budget 

and zero absorption. 

=IF(B2=0,"zero absorption”, IF(B2>A2,"Under Budget", "Within Budget")) 

 

VLOOKUP 

Description 

The VLOOKUP function performs a vertical lookup by searching for a value 

in the first column of a table and returning the value in the same row in 
the index number position. 

The VLOOKUP function is a built-in function in Excel that is categorized as 

a Lookup/Reference Function. It can be used as a worksheet function (WS) 
in Excel. As a worksheet function, the VLOOKUP function can be entered as 
part of a formula in a cell of a worksheet. 
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In the screenshot above, Vloookup function is used to search salaries 
applicable to different cadres as the range “I13:K20” and return the cadre 
budget per branch in range “B3:F21”. 

Syntax 

The syntax for the VLOOKUP function in Microsoft Excel is: 

VLOOKUP( value, table, index_number, [approximate_match] ) 

Parameters or Arguments 

value 

The value to search for in the first column of the table. 

table 

Two or more columns of data that is sorted in ascending order. 

index_number 

The column number in table from which the matching value must be 

returned. The first column is 1. 
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approximate_match 

Optional. Enter FALSE to find an exact match. Enter TRUE to find an 

approximate match. If this parameter is omitted, TRUE is the default. 

 

HLOOKUP 
 

Description 

The Microsoft Excel HLOOKUP function performs a horizontal lookup by 
searching for a value in the top row of the table and returning the value in 
the same column based on the index_number. 

The HLOOKUP function is a built-in function in Excel that is categorized as 

a Lookup/Reference Function. It can be used as a worksheet function (WS) 
in Excel. As a worksheet function, the HLOOKUP function can be entered as 
part of a formula in a cell of a worksheet. 

 

A menu of cadres and their salaries are shown in the screen shot above. 
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Syntax 

The syntax for the HLOOKUP function in Microsoft Excel is: 

HLOOKUP( value, table, index_number, [approximate_match] ) 

Parameters or Arguments 

value 

The value to search for in the first row of the table. 

table 

Two or more rows of data that is sorted in ascending order. 

index_number 
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The row number in table from which the matching value must be returned. 

The first row is 1. 

approximate_match 

Optional. Enter FALSE to find an exact match. Enter TRUE to find an 

approximate match. If this parameter is omitted, TRUE is the default. 

The index number may be more appropriately captures using the match 

function. 

 

MATCH 
 

Description 

The Microsoft Excel MATCH function searches for a value in an array and 
returns the relative position of that item. 

The MATCH function is a built-in function in Excel that is categorized as 

a Lookup/Reference Function. It can be used as a worksheet function (WS) 
in Excel. As a worksheet function, the MATCH function can be entered as 
part of a formula in a cell of a worksheet. 
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Matching columns 

 

As can be seen from the screen shot above, the relative position of Cadre in 

the range “M12:O12” is 1 while the relative position of Salary is 3. 

 

  



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 

Contact: Pontian Kay (+256790790707) 
Page 56 of 156 

 

Matching rows 

 

As can be seen from the screen shot above, the relative position of Branch  
Managers in the range “A1:A9” is 2 while the relative position of Ass.  
Managers is 3. 

Syntax 

The syntax for the MATCH function in Microsoft Excel is: 

MATCH( value, array, [match_type] ) 

Parameters or Arguments 

value 
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The value to search for in the array. 

array 

A range of cells that contains the value that you are searching for. 

match_type 

Optional. It the type of match that the function will perform. The possible 
values are: 

match_type Explanation 

1 (default) 

The MATCH function will find the largest value 

that is less than or equal to value. You should be 

sure to sort your array in ascending order. 

If the match_type parameter is omitted, it 
assumes a match_type of 1. 

0 

The MATCH function will find the first value that is 
equal to value. The array can be sorted in any 

order. 

-1 

The MATCH function will find the smallest value 

that is greater than or equal to value. You should 

be sure to sort your array in descending order. 
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EXCEL DATA TABLE 

A data table is a range that evaluates changing variables in a single 

formula. In other words, it's a simple what-if analysis: how does changing 
an input value change the results? You can examine the possibilities with a 

quick glance. (A data table isn't the same thing as the new table feature on 

the Insert tab.) 

One-variable data tables    Use a one-variable data table if you want to 

see how different values of one variable in one or more formulas will 
change the results of those formulas. For example, you can use a one-

variable data table to see how different interest rates affect a monthly 
mortgage payment by using the PMT function. You enter the variable values 

in one column or row, and the outcomes are displayed in an adjacent 

column or row. 

 

A two-variable data table uses a formula that contains two lists of input 

values. The formula must refer to two different input cells. 

 

https://support.office.com/en-us/article/PMT-function-0214da64-9a63-4996-bc20-214433fa6441
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In the screen shot above, the monthly payment arising from a $500,000 
mortgage contracted for 300 months with a down payment of $200,000 is 

$4,316.33. A data table is utilized to analyse how the monthly payment 
changes under different scenarios for the annual interest rate and 

repayment periods. The amounts range from $2,290.43 for 480 months 

with 5% interest rate 12,548.59 for 60 months with 20% interest rate. 
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GOAL SEEK 

If you have a formula and want to show a specific result, but you do not 

know what input values to change within the formula, then Excel’s Goal 

Seek feature is the one for you. 

Imagine you are calculating the payment terms on a loan. 

Your PMT formula gives you an amount of $4,316.33 but you can only 

afford to repay $2,850.  You can use Goal Seek to find out 
what Principal you can borrow based on your $$2,850 budget. 

 

Go to Data menu>>>What-if Analysis>>>Goal seek 

 

Input the target PMT value to be put in cell C15 ($2850) and apply goal 

seek on the number of payment periods (months). 

 

On pressing “OK”, the replace the number of months (300) the number of 
months for repayment required to reduce the PMT value (monthly 

installment) to $2850. 
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BOOLEAN LOGIC 

Named after the nineteenth-century mathematician George Boole, Boolean 

logic is a form of algebra in which all values are reduced to either TRUE or 
FALSE. Boolean logic is especially important for computer science because 

it fits nicely with the binary numbering system, in which each bit has a 
value of either 1 or 0.  

Most of people use the IF function all the time, for example to test if one 

value is larger than another value. But many times there is an easier way 
to do it! Let’s use Boolean logic instead – it will save you a lot of time and 

struggle. Boolean logic, or Boolean algebra, is a kind of algebra where 
you’re looking for a TRUE or FALSE result. 

Procedure: 

Create a condition that you want to be tested whether it’s true or false. 

E.g  =$B$4=H3 

 

 

The true/false statement can be converted into 1/0 (one or zero) by 

inserted two negative signs (--) outside the condition as shown in the 

screen shot below. 

=--($B$4=H3) 

 

 
=--($B$4=H3) 

 

=$B$4=H3 
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Using the Boolean logic in SUMPRODUCT FUNCTION 

 A SUMPPRODUCT function multiplies cells in the same row over a number 

of rows and sums the products thereby generated. 

The function multiplies corresponding components in the given arrays, and 
returns the sum of those products. 

Syntax 

SUMPRODUCT(array1,array2,array3, ...) 

Array1, array2, array3, ...   are 2 to 255 arrays whose components you 
want to multiply and then add. 

=SUMPRODUCT(--($B$4:$B$53=H3),$E$4:$E$53) 

 

 =SUMPRODUCT(--($B$4:$B$53=H3),$E$4:$E$53) 
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The Boolean logic converts Branches into 1/0 notation depending on 

whether the condition based on the Branches in column H and returns the 
total salary budget in column I. 

 

OFFSET 

Returns a reference to a range that is a specified number of rows and 

columns from a cell or range of cells. The reference that is returned can be 
a single cell or a range of cells. You can specify the number of rows and the 
number of columns to be returned. 

Syntax 

OFFSET(reference,rows,cols,height,width) 

Reference   is the reference from which you want to base the offset. 
Reference must refer to a cell or range of adjacent cells; otherwise, OFFSET 
returns the #VALUE! error value. 

Rows   is the number of rows, up or down, that you want the upper-left 

cell to refer to. Using 5 as the rows argument specifies that the upper-left 
cell in the reference is five rows below reference. Rows can be positive 

(which means below the starting reference) or negative (which means 
above the starting reference). 
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Cols   is the number of columns, to the left or right, that you want the 
upper-left cell of the result to refer to. Using 5 as the cols argument 

specifies that the upper-left cell in the reference is five columns to the right 
of reference. Cols can be positive (which means to the right of the starting 
reference) or negative (which means to the left of the starting reference). 

Height   is the height, in number of rows, that you want the returned 
reference to be. Height must be a positive number. 

Width   is the width, in number of columns, that you want the returned 
reference to be. Width must be a positive number. 

Application: 

The OFFSET function is used for may purposes. In the demonstration 

below, the function is used to total sales per department. 

NOTE: The departments are column headings, this makes use of 

SUMPRODUCT and SUMIFS function inefficient/unfeasible without using 
OFFSET. This is because SUMPRODUCT and SUMIFS function work well with 

criteria the row rather than column aligned. 

=OFFSET($B$4:$B$39,0,MATCH(J3,$B$3:$H$3,0)-1) 

  

 

 

 

 

=SUM(OFFSET($B$4:$B$39,0,MATCH(J6,$B$3:$H$3,0)-1)) 

The match function nested in the offset is for returning 

the appropriate number of columns to move (to the 

right) every time the formula is copied into a cell 

relating to another department 
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By using the offset function above the user may highlight one column and 

manages to sum across several other columns. 

The departmental sales may also be summed for each year as 

shown. 

SUMPRODUCT(OFFSET($B$4:$B$39,0,MATCH(J11,$B$3:$H$3,0)-1),--

($B$4:$B$39=$K$9)) 

 

 

 

The criteria for years may be enabled by a drop-down option in cell K11 as 

shown above. 

Other functions covered include: 

 Indirect 

 Row 
 Rows 

 Col 

 Column  

E X C E L P I V O T T A B L E S 

Introduction 

It is amazing how many highly experienced Excel users are unable to 

understand Pivot tables. 

Many users spend hours creating worksheet-based solutions that could have 

been addressed in a few seconds using a pivot table. 

=SUMPRODUCT(OFFSET($B$4:$B$39,0,MATCH(J11,$B$3:$H$3,0)-1),--($B$4:$B$39=$K$9)) 
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This session will empower you with a complete mastery of this essential 

Excel tool. 

By the end of this session you will be able to: 

 

• Creating a one dimensional pivot table report 

• Create a grouped pivot table report 
• Understand pivot table rows and columns 

• Use an external data source 
• Apply a simple filter and sort to a pivot table 

• Use report filter fields 
• Use report filter fields to automatically create multiple pages 

• Format a pivot table using PivotTable styles 
• Create a custom PivotTable style 

• Understand pivot table report layouts 
• Add/remove subtotals and apply formatting to pivot table 

fields 
• Display multiple summations within a single pivot table 

• Add a calculated field to a pivot table 
• Add a calculated item to a pivot table 

• Group by Text 

• Group by Date 
• Group by numeric value ranges 

• Show row data by percentage of total rather than value 
• Create a pivot chart from a pivot table 

• Embed multiple pivot tables onto a worksheet 
• Add slicers and timelines to a pivot table 

• Associate a single slicer and timeline to multiple pivot tables 
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Creating a one dimensional pivot table 

 

Here is the sample file we shall use in this lesson: 

 

This is the type of worksheet that pivot tables can work well with because 

the columns contain repeating data. 

The sample file contains over 2,000 rows of transactional data listing sales 

during the 18 month period from October 2007 to March 2009 inclusive. 

You can see from the data that the worksheet contains details of orders sold 

by a DVD wholesaler, along with the titles supplied on each order. 

Order 136438 was placed on 1st-Oct-07 and was ordered by Silver Screen 

Video. The order was sold by Frank Lee and there were four items on the 
order. Two of the films ordered were in the Drama genre and the other two 

were in the Biography and Comedy genres. 

A business may wish to ask several questions about sales during this period 

such as: 

• What were my sales by Genre? 

• How many units did each Employee sell? 

In this lesson, you will use a pivot table to answer both questions in less 

than 10 seconds! 

1.   Open Transactions-1 from your sample files folder. 
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This worksheet contains a large table named Data (see sidebar for more on 
using tables with Pivot Tables). The table looks like a regular range because 

it has had its Filter switched off and the Table style set to none. 

2.   Click anywhere inside the table. 

3.   Click Insert…Tables…Pivot Table. (Shortcut ALT, D, P or ALT, N, V) 

The first screen of the wizard appears. 

Notice that, because you clicked inside the table, it has automatically 

detected the table's name of data. 

4.   Click the OK button. (Next… Next….Finish) 

An empty pivot table is shown on screen and the PivotTable Field List 

appears on the right of the screen. 

Check the Genre, Qty and Total check boxes (in that order) on the 

PivotTable Field List. Simply by clicking on three fields you have answered 

the first question: 

What were my sales by Genre? 

5.   Format the values shown in column C of the pivot table so that they 

show two decimal places with a comma separator. 

i. Right-click on any value in column C. 

ii. Click Number Format... on the shortcut menu.  

iii. Click Number in the Category list. 

iv. Click the Use 1000 Separator check box. 

 

v. Click the OK button. 
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6. Clear all check boxes and then select the Employee and Qty check boxes. 

How many units did each Employee sell? 

 

7.   Name the pivot table transactions.  

i Click inside the Pivot Table. 
ii Click PivotTable Tools…Options…PivotTable…PivotTable Name. 

iii Type Transactions into the PivotTable Name box. 
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8.   Name the pivot table worksheet Pivot Table. 

 

9.   Save your work as Transactions-2. 

Pivot Tables, Ranges, Named Ranges and Tables 
You can create a Pivot Table that is associated with a Range, a Named 

Range or a Table. The fatal flaw of named ranges is that they only expand 

and contract when rows are inserted or deleted and NOT when data is 
added to the end of the range. Fortunately, Excel 2007 has the fantastic 

new Table structure. Tables are wonderful to use as a data source for Pivot 

Tables because they are truly dynamic. 

Drilling down into pivot table data 

Whenever Excel shows a total, it is possible to “drill down” to see the 
transactions that were used to calculate the total. When you double-click on 

a total, (such as the total sales for action movies in cell C5), a new 
worksheet opens showing the source transactions. You will have to 

manually delete this worksheet after viewing the transaction list. 

Activating a pivot table 
Pivot tables are a little like charts in that you cannot work upon their design 

unless they are activated. To activate, you simply click anywhere inside the 
pivot table. When the pivot table is activated, the PivotTable Field List 

appears along with the PivotTable Tools tab on the Ribbon.Creating a 

grouped pivot table report 

 

1.   Open Transactions-2 from your sample files folder (if it is not already 

open). 

2.   Select the Pivot Table worksheet (if it is not already selected). 

3.   Click inside the pivot table to show the PivotTable Field List. 

4.   Click Genre in the PivotTable field list. 

Each Employee’s sales for each genre are now shown in the report. 
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5.   Add Title information to the pivot table. 

Click Title in the PivotTable Field List.
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The report now breaks sales down by Employee, Genre and Title. 

 

6.   Collapse the outline to show only sales by Employee. 

 i. Right-click cell A4. A shortcut menu appears. 

You can also collapse an outline from the Ribbon 

The fastest way to collapse and expand an outline is by using the right-click method 

described in the text. It is also possible to do this in a less efficient way using the 

Ribbon: 

1. Click cell A5. A5 becomes the Active Field. 

2.   Click: PivotTable Tools…Options…Active Field…Collapse Entire Field 

 

ii. Click: Expand/Collapse…Collapse Entire Field. 

The Pivot Table collapses to the level of Employee. 
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7. Expand Dan Armstrong’s sales to show full details. 

Click the small + sign to the left of cell A5. 

 

Sales are expanded to show full details of Dan’s sales. 

 

8. Collapse the outline so that Dan’s sales by Genre are shown without Title 

details. 

i. Right-click cell A6. A shortcut menu appears. 

ii. Click: Expand/Collapse…Collapse Entire Field. 

The Title level of the Pivot Table collapses to show Dan’s sales by Genre but 

not by Title. 

 

9. Collapse the outline to only show sales by Employee. 

Click the small minus sign to the left of cell A5. 

The outline contracts to show only the Employee level. 
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10. Save your work as Transactions-3. 

 

Understanding Pivot table rows and columns 

 

1.   Open Transactions-3 from your sample files folder (if it isn’t already 

open). 

2.   Select the Pivot Table worksheet (if it is not already selected). 

3.   Click inside the pivot table to display the Pivot Table Field List. 

At the lower right of the screen, you can see four panes: 

 

 

At the moment, we have three columns in the Row Labels list and one in the 
Values list. This creates a pivot table that shows sales first by Employee, 

then grouped by Genre and then grouped by Title. 
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4. Remove the Genre and Title rows from the Row Labels list. 

i. Click Genre and then click Remove Field from the shortcut menu. 

ii. Click Title and then click Remove Field from the shortcut menu. 

 

5. Add the Genre to the pivot table as a Column Label. 

Instead of checking the Genre in the PivotTable Field List, you need to drag 

it from the PivotTable 

Field List to the Column Labels list below. 
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The pivot table now shows sales for each employee by genre with the 

genres listed along the top row as column labels: 

 

6. Add the Title field to the Column Labels list. 

Drag the Title field from the PivotTable Field List to the Column Labels list.
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Make sure that you place Title below Genre. 

 

A small + sign is now shown next to each genre: 

 

7. Expand and collapse the Action genre. 

i. Click the small + sign to the left of Action in cell B4. 

The field expands to show each title within the Action genre: 

 

ii. Click the small – sign that has now appeared to the left of Action in cell 

B4. 

The outline collapses back to the genre level: 
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8. Save your work as Transactions-4. 

 

 

 

 

Using an external data source 
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Excel is capable of importing data from a huge range of sources such as a 
CSV (comma-separated value) file. Once the data is imported into an Excel 

worksheet, it is then possible to create a pivot table from the worksheet. 

It is also possible to use data directly (without first importing it) from an 
external data source. This is usually a database such as Microsoft Access or 

one of its big brothers; SQL Server or Oracle. 

 

The difference between a relational database and Excel 

A relational database (such as a Microsoft Access database) contains several 

tables joined together by relationships. Conceptually, each table is similar to 

an Excel table but with more sophisticated validations. In this respect, Excel 
is a little like a simple “one table database”. It is the relationships between 

the tables that make a true database “relational”. For example, the 
database used for this lesson has a Director table and a Film table. The 

relationship between them is defined as: - One director may direct many 
films but a single film has one, and only one, director. When this 

relationship is defined, Access will prevent a director from being deleted if 

there is an existing association with a film. 

It is a huge mistake to store relational data in Excel, rather than in a true 

relational database. Excel is the world’s most powerful analytical tool, but it 

is not a database! 

You can also use data directly from an OLAP cube. An Online Analytical 

Processing (OLAP) cube resides on an OLAP server and is a special sort of 
database that is optimized for reporting speed. OLAP technology would 

typically only be used when working with very large business databases. 

 

In this lesson, we will create a worksheet that analyses data from an Access 

database. 

 

Important: You may not be able to complete this lesson unless you have 
Microsoft Access 2007 or later versions installed on your machine. Access is 
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included in the professional version of Office 2007 but, unfortunately, not 

the standard version. 

 

1. Open a new blank workbook. 

2. Save the new workbook as Film Details-1. 
3. Click Insert…Tables…PivotTable. The Create PivotTable dialog appears. 

4. Create a pivot table using the qryFilmDetails query in the Film Library 
Access database as an external data source. 

i Click the Use an external data source option button.  
ii Click the Choose Connection… button. 

 
The Existing Connections dialog appears.  

iii Click the Browse for More… button. 

iv Navigate to your sample files folder and select the Film Library Access 

database file. 
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v. Click the Open button. 

You are presented with a list of all tables and queries in the database. 

 

vi. Click the qryFilmDetails query and then click the OK button.  

vii. Click the OK button. 

5. Use the pivot table to display all of the film titles, and each film’s budget. 

Check the Film Budget (Millions $) check box and the Film Title check box in 

the PivotTable Field List. 
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A list of films and budgets is displayed. 

 

6. Save your work (still with the name: Film Details-1). 

 

You can also create a pivot table from an Access database like this: 

 

1.   Data…Get External Data…From Access. 

2.   Select the Access database file and then click Open. 

3.   Select the table or query to use for the data source and click OK. 

4.   Select PivotTable Report in the Import Data dialog and then click OK. 

Important: A pivot table does not automatically update when the data 

source changes until you click: 

 

PivotTable Tools…Options…Data…Refresh... a pivot table will not update to 
reflect changes to the source data (whether it is a worksheet or an external 

data source). By default, Excel invisibly stores a local copy of data from an 

external data source. This means that you can still use the pivot table even 
if the source database is down. If you are working with very large data sets, 

you can switch off the local storage of data by unchecking: PivotTable 

Tools…Options…PivotTable…Options…Data…Save Source data with file. 
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Applying a simple filter and sort to a pivot table 

 

1.   Open Transactions-4 from your sample files folder  

2.   Select the Pivot Table worksheet 

3.   Click inside the pivot table to display the Pivot Table Field List. 

4.   Remove the Genre and Title column Labels. 

5.   Click the drop-down arrow next to Row Labels in cell A3. 

Filter options appear. 

6.   Filter the pivot table so that only female employees are shown. 

Uncheck the check boxes next to each male employee (see sidebar). 
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Notice the filter icon in cell A3 showing that the pivot table has been 

filtered.  

This is a very long-winded way to filter out the male employees. In a real-

world workbook, you would probably create a Gender column in the source 
data containing the values M or F. You could then filter by gender with a 

single check box. 

7. Sort Employee names in Z-A order. 

At the moment, the names are sorted in A-Z order. 

i. Click cell A4. When you click on any Employee name, it makes Employee 
the active field. 

ii. Click PivotTable Tools…Options…Sort…Z-A.  

The Pivot Table is sorted in Z-A order. 

 

8.   Sort Employee names by first name. 
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It isn’t possible to automatically sort by first name. To do this, we would 
need First Name to be a different field to Last Name. If there were a lot of 

names, we’d attend to this in the source data by splitting the Employee 
Name column into two. Because there are only twelve names, it will be 

quicker to manually sort the list. 

i.       Click in cell A4 to make it the active field. 

ii.       Click: PivotTable Tools…Options…Sort…Sort.  

The Sort dialog appears. 

iii.      Click the Manual option button. 

 

iv.     Click OK. 

v.      Click and drag the border of each Employee name to move them to 

the desired position. 

Look for the four headed arrow cursor shape before clicking the mouse. 

 

 

 

 

 

 

 

 

 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 88 of 156 

 

 

 

 

 

 

 

9.  Remove the filter. 

i. Click the filter button at the top right of cell A3.  
ii. Check the Select All check box. 

iii. Click the OK button. 

10. Save your work as Transactions-5. 

Filters are not inherited from source data 

If the data associated with a Pivot Table (whether a table, range or named 
range) has a filter applied to it (or contains subtotals) this will not be 

carried forward into the Pivot Table. If you need the same filter in your 
Pivot table, you must first create the Pivot Table and then apply the same 

filter. Another way to achieve this is to copy the (filtered) data to a new 

worksheet and to create the Pivot Table from this subset of the actual data. 

Using report filter fields 

 

In earlier versions of Excel, report filters were called Page Fields. 

1.   Open Transactions-5 from your sample files folder 

2.   Select the Pivot Table worksheet  

3.   Drag the Genre field from the PivotTable Field List to the Report Filter 

list. 
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Notice that a filter has appeared at the top left of the pivot table (in cells A1 

and B1): 

 

The filter currently shows all sales for all genres. 

4.   Use the report filter field to display sales for the Comedy genre.  

i. Click the drop-down list arrow in cell B1. 

ii. Click Comedy in the drop-down list. 
 

 
 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 90 of 156 

 

iii. Click the OK button. 

Notice that the Sum of Qty values now change to only show quantities sold 

in the Comedy genre. 

5.   Use a report filter field to show sales in the Comedy genre for June 

2008. 

i Drag the Order Date field from the PivotTable Field List down to the Report 
Filter List. 

 
 

ii Click the drop-down arrow in cell B2. 

 

 
 

iii Make sure that the Select Multiple Items check box is checked. 

iv Uncheck the (All) check box. 
v Scroll down the list and check all of the June 2008 check boxes. 

vi Click the OK button. 

vii Only goods sold in the Comedy genre during June 2008 are now displayed. 
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6.   Save your work as Transactions-6. 

Using report filter fields to automatically create multiple pages 

In this lesson, we cater for the following scenario: You have been asked to 
print out a sales listing for each employee. This involves printing a total of 

24 separate reports. It is easy, but time consuming, to print each sheet 
manually. You would need to perform 24 filter and print operations. Surely 

there’s a better way? 

Of course there is. We can use a report filter to automate the whole task 

and print all 24 reports in one operation. 

1.   Open Transactions-6 from your sample files folder 

2.   Select the Pivot Table worksheet. 

3.   Remove all filters. 

There is a quick way to remove all filters from a pivot table. 
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i.       Click inside the pivot table to activate it. 

ii.       Click: PivotTable Tools…Options…Actions…Clear…Clear Filters. 

4.   Change the fields displayed by the pivot table so that they match the 

following: 

 

You learned to do this in the Lesson: Understand pivot table rows and 

columns. Note that the   field automatically appears in the Column 

Labels list when you add more than one field to the Values list. 

Your pivot table now looks like this: 

 

5.   Create separate worksheets detailing each employee’s sales. 

i.       Click anywhere within the pivot table. 

ii.       Click: PivotTable Tools…Options…PivotTable…Options…Show Report 

Filter Pages… 

The Show Report Filter Pages dialog appears. 
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Because there is only one report filter, there is only one choice. If you had 

multiple report filters, you could choose which filter you wanted to use.
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iii.       Click the OK button. Something amazing happens! 

24 worksheets are instantly created, one for each employee. 

 

Here is Chuck West’s sheet: 

 

iv.       You can see that it contains a copy of the original pivot table with a 

filter set for Chuck. 

6.   Print preview all worksheets. 

i.       Click on the first employee’s tab (West, Chuck) 

ii.       Hold down the <Shift> key. 

iii.       Use the worksheet scroll bar buttons so that the last employee’s tab 

(Armstrong, Dan) is visible. 

 

iv.       Click on the last employee’s tab (Armstrong, Dan). 

You have now selected all of the employee worksheets (you don’t want to 

print the Pivot Table or Data worksheets). 

v.       Click: Office Button…Print…Print. 

Note that Active Sheets is selected by default. 
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vi.       Click the Preview button.  

vii.       Close the Print Preview. 

7.   Save your work as Multiple Sheets-1. 

 

Formatting a pivot table using pivot table styles 

 

You have already learned how to use a built-in style to format an Excel 

table. PivotTable styles are used in a similar way. 

1.   Open Transactions-6 from your sample files folder.
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2.   Remove all existing fields from the pivot table. 

A fast way to do this is to drag each field from the field selection panes to 

the field list above: 

 

3.   Select the fields shown below. 

 

4.   Filter to only show the genres: Action, Adventure and Animation for 

employees: Chuck West, Julie 

Spears and Dan Armstrong. 

You learned how to do this in an earlier lesson 
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5.   Apply the PivotTable style: Dark 9. 

Click: PivotTable Tools…Design…PivotTable Styles…Dark…Pivot Style Dark 9. 

 

 

 

6.   Enable Banded Rows and Banded Columns. 

i.       Check: PivotTable Tools…Design…PivotTable Style Options…Banded 

Rows. 

ii.       Check: PivotTable Tools…Design…PivotTable Style Options…Banded 

Columns. 
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The pivot table changes to show colored lines separating each row and 

column. 

 

The other two options in the PivotTable Style options group are Row 

Headers and Column Headers. In the Dark 9 style, the column headers are 
shown in a contrasting color. The Column Headers check box allows you to 

switch this color off. Some of the other designs. 

Also show row headers (cells A6:A8) in a contrasting color. If you were 
using this type of design, you could switch this color off with the Row 

Headers check box. 

7.   Save your work as Transactions-7. 

 

Creating a custom pivot table style 

 

In the Lesson: Create a custom table style; you learned how to create a 
custom style for an Excel table. PivotTable custom styles are applied in a 

similar way. 

1.   Open Transactions-7 from your sample files folder 

2.   Remove the existing style. 

i.      Click the pivot table to activate it. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 99 of 156 

 

ii.     Click PivotTable Tools…Design…PivotTable Styles…Light…None. 

 

Notice that this style is different from the default style. The default pivot 

table style is Light 16. 

3.   Create a custom pivot table style called Corporate by duplicating the 

Medium8 built in style. 

You will usually find that modifying a duplicate of an existing style is easier 

than creating a style from scratch. 

i.       Right-click on: PivotTable Tools…Design…PivotTable 

Styles…Medium…Pivot Style Medium8 

ii.       Click Duplicate… from the shortcut menu. 

 

 

iii.       The Modify Pivot Table Quick Style dialog appears. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 100 of 156 

 

Notice that some of the Table Elements are shown in bold face. These are 

the elements that have had formatting applied to them: 

 

iv.       Type the name Corporate into the Name text box. 

 

v.   Click the OK button to dismiss the dialog. 

4.   Apply the new corporate style to the pivot table. 

i.    Click: PivotTable Tools…Design…PivotTable Styles…Custom…Corporate. 

5.   Modify the Corporate style so that it shows the Grand Total column in 

boldface. 

i.      Right-click on: 

PivotTable Tools…Design…PivotTable Styles…Custom…Corporate. 

ii.      Click Modify… from the shortcut menu. 

 

iii. Select Grand Total Column from the Table Element list.  
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iv. Click the Format button 
v. Select the Font tab. 

vi. Select the Font style: Bold. 

 

vii.       Click the OK button. 

viii.       Click the OK button again. 

The Grand Total column is now shown in bold face. 

 

6.   Save your work as Transactions-8. 

 

Pivot Table Layouts 

 

1.   Open Transactions-8 from your sample files folder 

2.   Remove all existing fields from the pivot table by dragging them up into 

the PivotTable Field List. 

It is important to realize that when you drag a field back to the PivotTable 
Field List, you do not clear any filter conditions associated with the field. 

You can still see the filter icon next to each filtered field (see below). 
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3.   Select the fields shown below. 

You learned how to do this in the Lesson: Understand pivot table rows and 

columns. 

 

4.   Expand the Employee field to also display Genres. 

You learned how to do this in the Lesson: Create a grouped pivot table 

report. 

The pivot table is shown in compact form layout. This is the default layout. 

 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 103 of 156 

 

This layout is useful when you need the report to take up the minimum 
amount of space on screen or paper. Subsidiary fields are only slightly 

indented from their parent field. 

5.   Change the report layout to Outline Form. 

Click: 

PivotTable Tools…Design…Layout…Report Layout…Show in Outline Form 

Outline Form is the classic pivot table layout that was the default in earlier 

versions of Excel. It takes up more space but is more readable as each field 

has its own column label. 

6.   Change the report layout to Tabular Form. 

Click: PivotTable Tools…Design…Layout…Report Layout…Show in Tabular 

Form 

 

This layout is very easy to read because it is similar to a regular Excel table 

with totals shown at the bottom of each column. 

7.   Save your work as Transactions-9. 
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Applying formatting to pivot table fields 

 

1.   Open Transactions-9 from your sample files folder (if it isn’t already 

open). 

2.   Apply a Filter to show only the Biography and Thriller genres. 

You learned to do this in the Lesson: Apply a simple filter and sort to a pivot 

table. 

3.   Add the Title field to the pivot table as a third-level row label. 

Drag the Title field from the PivotTable Field List to the Row Labels list. 

 

4.   Expand all of the Genre fields to show all Titles. 

You learned to do this in the Lesson: Create a grouped pivot table report. 

Because the pivot table layout is set to Tabular Form, subtotals are 
displayed by all subsidiary groups. Both Employee and Genre are showing 

subtotals. 
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5.   Format the Genre subtotal fields using the Total cell style. 

i.     Hover the mouse cursor over the left edge of the Biography Total label 

in cell B9. 

ii.       Make sure you see the black arrow cursor shape and then click 

Transactions-9 to select. 

 

Notice that when you select the field all Genre subtotal cells are selected. iii.     

Click: Home…Styles…Cell Styles…Total. 

iv.     The Total style is applied to all Genre subtotal fields. 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 106 of 156 

 

 

6.   Remove Genre subtotals. 

i.     Right-click any of the Genres in column B. 

ii.    Click Subtotal “Genre” on the shortcut menu. 

 

The Genre subtotal fields are removed. 

7.   Remove the Grand Total. 

i.      Click: PivotTable Tools…Design…Layout…Grand Totals. 

ii.     Select Off for Rows and Columns. 

8.   Save your work as Transactions-10. 

Displaying multiple summations within a one pivot table  
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It is possible to show the same Value field many times in the same pivot 
table. This is useful when you need to display different summations (such 

as Average, Sum and Total) on a single pivot table. 

 

1.   Open Transactions-10 from your sample files folder (if it is not already 

open). 

2.   Remove the Genre and Title fields from the Row Labels list. 

3.   Add two more Total fields to the Values list. 

 

4.   Change the new totals to show Average sales and Maximum sales for 

each employee. 

i.       Right-click anywhere in column C within the pivot table.  

ii.       Click Value Field Settings… on the shortcut menu. 

iii.       Select Average in the Summarize value field by list. 
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iv.       Click the OK button. 

v.       Use the same technique to make the Sum of Total3 field display the 

maximum (Max) value. 

 

5.   Format the Average of Total2 field so that it displays two decimal 

places. 

i.      Right-click anywhere in column C within the pivot table.  

ii.      Click Number Format… on the shortcut menu. 

iii.      Select the Number category with two decimal places. 

 

iv.      Click the OK button. 

 

6.   Add a Grand Total 
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i.      Click: PivotTable Tools…Design…Layout…Grand Totals…On for Rows 

and Columns. 

 

7.   Save your work as Transactions-11. 

Switching grand totals on and off with the right-click method 

 

In this lesson, you used the Ribbon to enable or disable the Grand Total. It 

is also possible to do this faster using the following right click method: 

 

1.   Right click anywhere within the pivot table. 

2.   Click PivotTable Options...from the shortcut menu. 

3.   Click the Totals & Filters tab. 

4.   Click one, or both of the Grand Totals check boxes to enable/disable. 

 

Adding a calculated field to a pivot table 

 

1.   Open Transactions-11 from your sample files folder  

2.   Remove the Average of Total2 and Max of Total3 Fields. 

You learned how to do this in the Lesson: Understand pivot table rows and 

columns. 
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3.   Format the Sum of Total field to show a comma thousand separator. 

i.       Right-click anywhere in column B within the pivot table.  

ii.      Click Number Format… on the shortcut menu. 

iii.     Click the Number category. 

iv.     Check the Use 1000 Separator (,) check box.  

V.      Click OK. 

4.   Add a calculated field called Bonus that will calculate 3% of total sales. 

i.       Click: PivotTable Tools…Options…Tools…Formulas…Calculated Field… 

ii.      Type Bonus in the Name text box. 
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vii. Click in the Formula text box and remove the zero, leaving only an = sign. 
viii. Select Total in the Fields list and then click the Insert Field button.  

ix. The word Total is added to the Formula. 

vi.       Type to complete the formula 

vii.     Click the OK button. 

A new field called Bonus has now appeared in the PivotTable Field List and a 

Sum of Bonus field has appeared in column C. 

 

5.   Change the names at the top of columns B and C to Sales and Bonus Due. 

i.       Click cell B5. 

ii.       Type the new name Sales.  

iii.       Press the <Enter> key. 

iv.       Use the same technique to change the name in cell C5 to Bonus Due. 

6.   Remove the Field Header (this is currently shown in row 4). 

i.       Click: PivotTable Tools…Options…Show/Hide…Field Headers. 

 

The three items in the Show/Hide group are toggle buttons allowing you to add 

and remove different pivot table artifacts. The pivot table is now well formatted. 
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The Values label has disappeared but so has the Employee label. If you wanted 
to keep the Employee label you would have had to hide row 4 instead (See tip 

below). 

Hiding pivot table rows 

 

In this lesson, we switched off the field headers in order to suppress the Values 

label in cell B4. This had the side effect of also removing the word Employee 

from cell A5. 

If you wanted to keep the Employee label but suppress the Value label, you 

would need to hide row 

4. To hide the row, right-click the row header (the number 4 on the left of the 

row) and then click Hide from the shortcut menu. 

7.   Save your work as Transactions-12. 

Adding a calculated item to a pivot table 

 

One field will usually consist of several items. For example, the Genre field 

consists of items such as Drama, Comedy, Action, Biography etc. If you wanted 
to show a sales target of Sales + 10%, you would simply create a calculated 

field. 

Sometimes, you will want to perform a calculation upon a selected number of 
items within a field. In this lesson’s example, you are interested in total sales for 

the Drama, Comedy and Action genres, as they are your top sellers. 

Calculated items provide a solution to this problem. In this lesson, we will add a 

calculated item to find the total sales in these genres. 
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1.   Open Transactions-12 from your sample files folder (if it is not already 

open). 

2.   Clear all filters from the pivot table. 

Click: PivotTable Tools…Options…Actions…Clear…Clear Filters. 

3.   Remove all of the existing fields from the pivot table and replace them with 

the following: 

 

4.   Format the Sum of Total to show two decimal places with a thousand-

comma separator. 

i. Right-click anywhere in column B within the pivot table.  
ii. Click Number Format… on the shortcut menu. 

iii. Click the Number category. 
iv. Check the Use 1000 Separator (,) check box.  

v. Click OK. 

Your pivot table now looks like the one shown below. 

 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 115 of 156 

 

5.   Add a calculated item to show total sales for the genres: Drama, Comedy 

and Action. 

I.       Click any pivot table cell in column A. 

II.       Click: PivotTable Tools…Options…Tools…Formulas…Calculated Item… 

The Insert Calculated Item dialog appears. This is very similar to the Insert 

Calculated
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Field dialog. The dialog is confusing because it shows many fields and items 
that would not be valid for the Genre field. They are not grayed out, as you 

would expect. 

iii.       Name the calculated item Drama, Comedy & Action. 

 

iv.       Select the Genre field and the Drama item and then click the Insert 

Item button. 

The formula changes to include the Drama item.  

 

v.       Type a + operator into the formula. 

vi.       Add the Comedy and Action items in the same way so that your 

formula is the same as the following: 

 

vii.       Click the OK button. 

A total for Drama, Comedy & Action appears at the bottom of the pivot 

table. 

 

Notice that this addition has corrupted the Grand Total as Drama, Comedy 

and Action are included in the Grand Total twice. 

6.   Filter the individual Drama, Comedy and Action fields so that they are 

no longer shown or included in the Grand Total. 

Because the Field Headers are currently switched off, you cannot apply a 

filter. 

i.       Click: PivotTable Tools…Options…Show/Hide…Field Headers. 
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ii.       The Genre field header appears in cell A4. 

 

x. Click the drop-down arrow to the right of cell A4. 

xi. Remove the individual Drama, Comedy and Action items by unchecking 

their check boxes. 

 

v.       The Grand Total is now correct. 

 

7.   Save your work as Transactions-13. 

 

Grouping by Text 

 

In the Lesson: Add a calculated item to a pivot table, we used a calculated 

item to show a group total for the Action, Comedy & Drama genres. 
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Another solution to this problem would be to create a group for these three 
genres. The pivot table could then show group totals. We’ll push things a 

little further, in this lesson, by placing each of the genres into three groups: 

•    Action, Comedy & Drama 

•    Crime, Biography & Fantasy 

•    Adventure, Sci Fi, Thriller & Animation 

1.   Open Transactions-13 from your sample files folder 

2.   Remove all of the existing fields and filters from the pivot table 

(including the calculated item added in the last lesson). 

You’ll often want to remove all fields and filters from your pivot table to 

start again. To do this, 

click: PivotTable Tools…Options…Actions…Clear…Clear All 

3.   Add the following fields to the pivot table. 

 

4.   Format the Sum of Qty field so that it shows 0 decimal places and a 

comma separator for thousands. 

I.       Right-click anywhere in column B within the pivot table. II.       Click 

Number Format… on the shortcut menu. 

III.       Click the Number category. 

IV.       Select the Number category and set 0 decimal places with a 

thousand separator. 

 

V.       Click the OK button. 
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5.   Add a group for the Action, Comedy and Drama genres. 

I.       Click on the Drama field in column A (cell A11). 

II. Hold down the <Ctrl> key and then click on the Comedy (A9) 

and Action (A5) fields in column A. Cells A11, A9 and A5 are now selected. 

iii.       Right-click on any of the selected fields and click Group in the 

shortcut menu. 

The fields are grouped: 

 

6.   Change the Genre2 label to Category and the Group1 label to Action, 

Comedy & Drama. 

The default names are not very descriptive. Single-click (be careful not to 

double-click) on each field (cells A4 and A5) and then type in the new 

labels. 

 

7.   Create the Crime, Biography & Fantasy group and the Adventure, Sci 

Fi, Thriller & Animation group. 

Do this in exactly the same way. (This time you will select the Genres in 

column B).
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8.   AutoSize column A and collapse all categories. This was covered in the 
Lesson: Create a grouped pivot table report. Your pivot table should now look 

like this: 

 

9.   Add subtotals for each group. 

i.      Right-click anywhere in column A within the pivot table.  

ii.      Click Field Settings from the shortcut menu. The Field Settings dialog 

appears. 

iii.       Click the Automatic option button in the Subtotals section. 

 

iv.       Click OK. 

v.       Expand the category groups. 

Subtotals are shown for each defined group. 

 

10. Save your work as Transactions-14. 
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Grouping by date 

 

Excel’s ability to summarize transactional data by monthly totals is extremely 

difficult to achieve without a pivot table. 

In previous versions of Excel, this feature was so well hidden that most Excel 
users did not even know it was there. Things are a little better with the new 

Ribbon interface. 

1.   Open Transactions-14 from your sample files folder. 

2.   Remove all of the existing fields from the pivot table. 

You will often want to remove all fields and filters from your pivot table to start 

again. To do this, click: PivotTable tools…Options…Actions…Clear…Clear All 

3.   Add the following fields to the pivot table. 

 

Sales are now shown for every employee and for every date. Sales are 
summarized by day but it is more likely that you will want to show sales by 

week, month, quarter or year. 

 

4.   Show monthly sales for each employee. 

i.       Right-click on any of the dates in row 5.  

ii.       Click Group on the shortcut menu. The Grouping dialog appears. 
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iii.       Select Months and Years. 

When you group by months, be very careful that you also group by years. If you 

do not, you will get October 2007, 2008 and 2009 grouped into a single total! 

 

Grouping using the Ribbon 

 

In this lesson, we use the right click method to display the Grouping dialog in 
order to group fields. It is also possible to do this using the Ribbon but it is a 

little more involved and requires more clicks. 

1.   Click the Order Date field to make it the Active Field. 

2.   Click: PivotTable Tools…Options…Group…Group Field. 

The Grouping dialog is then displayed. 

 

iv.       Click the OK button. 

v.       The pivot table is now grouped by year and by month. 

 

5.   Collapse the pivot table to show sales by year. 

i.       Right-click cell B5 to display the shortcut menu for the Years field.  
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ii.       Click: Expand/Collapse…Collapse Entire Field.  Sales are now 

displayed by year. 

 

6.   Expand the pivot table to show sales by month and year. 

i.       Right-click cell B5 to display the shortcut menu for the Years field.  

ii.       Click: Expand/Collapse…Expand Entire Field.  

Sales are now displayed by month and year 

7.   Apply a filter to show sales for Jan, Feb and Mar 2009. 

i.      Select cells Q5:S6. Make sure that you include the year (Q5) otherwise; 

you will see sales for Jan/Feb/Mar 2008 and 2009. 

 

ii.       Right-click the selected cells. 

iii.       Click: Filter…Keep Only Selected Items on the shortcut menu. 

iv.       Scroll the screen left so that you can see column A. 

8.   Save your work as Transactions-15. 
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Grouping by numerical values 

 

1.   Open Employee Age Profile-1 from your sample files folder. 

2.   Convert the range A3:C27 into a table named Data. 

In Excel 2007, it is best practice to base pivot tables upon tables (we would have 

used a named range in earlier Excel versions). 

i Click anywhere in the range A3:C27. 

ii Click: Insert…Tables…Table. 
iii Click OK. 

iv Type the name Data into: 

Table Tools…Design…Properties…Table Name 

3.   Create a pivot table from the Data table. 

i Click anywhere inside the table.  
ii Click: Insert…Tables…PivotTable.  

iii Click OK. 

4.   Add the following fields to the pivot table: 

 

(The order is important. Age must come before Name). The pivot table now 

groups employees by age. 
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Where two employees are the same age, they are grouped together. The 

challenge for this lesson will be to group employees into different age bands. 

5.   Group the pivot table into the age bands: Under 25, 25-34, 35-45 and Over 

45. 

i Right-click any of the ages in column A (for example: cell A6). 

ii Click Group from the shortcut menu. The Grouping dialog is displayed. 

iii Type the following values into the dialog: 

 

This tells Excel to group into the ages: 

1.   Less than 25 

2.   between 25 and 45 in bands of 10 years 

3.   Over 45 

iv.     Click the OK button. 

Ages are now grouped as defined: 



 
 

Advanced Excel Training for ICPAU in partnership with Summit Consulting Ltd 
Contact: Pontian Kay (+256790790707) 

Page 126 of 156 

 

 

6.   Change the Row Labels label in cell A3 to Age Group. 

i. Click once on cell A3. 
ii. Type Age Group into the cell. 

 

 
iii. Press the <Enter> key. 

7.   Save your work as Employee Age Profile-2. 

 

Displaying row data by percentage of total 
 

In this lesson, we want to discover which genres each employee is best at 
selling. This will enable the company to allocate sales leads for each genre to the 

most competent salesperson in that genre. This time we are not interested in 

total sales but the percentage sales by genre for each employee. 

As a bonus, we will see the percentage market share of each genre. 

1.   Open Transactions-15 from your sample files folder 

2.   Remove all of the existing fields and filters from the pivot table (including 

the calculated item added in the last lesson). 
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You will often want to remove all fields and filters from your pivot table to start 

again. To do this, click: PivotTable Tools…Options…Actions…Clear…Clear All 

3.   Add the following fields to the pivot table. 

 

4.   Format the Sum of Total field to show two decimal places and thousand 

separators. 

 

Sales are now shown for every employee and for every genre. 

 

5.   Show sales values as a percentage of each row total. 

i. Right-click on any of the numerical values in the pivot table.  
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ii. Click Value Field settings in the shortcut menu. The Value Field Settings dialog 
is displayed.  

iii. Click the Show values as tab. 

 
iv. Select % of row in the Show values as drop down list. 

 

v. Click the OK button. 

Values are now shown as a percentage of each employee’s sales: 
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You can see at a glance that Alfred Hawking does very well with sales in the 

Action genre, and that Paul Goodman is our star performer in the Drama genre. 

We should keep Michael Hicks and Julie Spears away from Science Fiction sales! 

6.   Save your work as Transactions-16. 

 

Creating a pivot chart from a pivot table 

 

This Expert Skills course assumes that you already understand normal Excel 

charts. 

When you create a pivot chart from a pivot table, it is important to realize that 
the chart always matches the data shown in the pivot table. You make changes 

to the source data of the chart by modifying the pivot table underpinning it. 

1.   Open Transactions-16 from your sample files folder. 

2.   Change the Sum of Total field so that it displays cash values rather than a 

percentage of the total. 

i. Right-click on any of the percentage values in the pivot table.  
ii. Click Value Field settings in the shortcut menu. The Value Field Settings 

dialog is displayed.  
iii. Click the Show values as tab. 

iv. Select Normal from the drop-down list. 
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v. Click the OK button. 
 

3.   Filter the pivot table so that sales are only shown for the three employees: 

Jane Anderson, Dan, Armstrong and Lucille Ashe. 

4.   Filter the pivot table so that sales are only shown for the three categories: 

Action, Comedy and Crime. 

 

5.   Create a Clustered Column pivot chart from the pivot table. 

i. Click anywhere in the pivot table to activate it. 

ii. Click: PivotTable Tools…Options…Tools…PivotChart. 

iii. Click the Clustered Column chart type. 

 

iv.       Click the OK button. 

A clustered column chart is shown embedded in the worksheet. 
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While this is sometimes what you want, most of the time you will want to place 

your chart into a worksheet of its own (see note below). 

6.   Move the chart to its own worksheet. 

i.       Click on the chart to activate it. 

ii.       Click: PivotChart Tools…Design…Location…Move Chart. 

iii.       The Move Chart dialog appears.  

iv.       Complete the dialog as follows: 

 

v.       Click the OK button. 

The chart now resides in its own chart sheet. 
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7.   Save your work as Transactions-17.
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Inserting slicers and timelines  
Now, let us add a new slicer and timeline tool. To do so, click inside the 

PivotTable and click the contextual Analyze tab. In the Filter group, click 
Insert slicer. The resulting dialog will display the date field. Check it out, as 

shown below, and click OK. 

 

 

Use the slicer and the timeline together 
 

With the new slicers, you can quickly filter the data by category, employee, 

genre and dates. To see how this works, check comedy in the slicer. Then, 
click the months of September and October 2013. The figure below shows 

the results — a single record for just comedy even though other records 
exist for other months. You could add a slicer for each field, if doing so 

makes sense. 
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Advantages of placing charts on chart sheets 

1.   They are easier to find, as you can give each sheet a meaningful name. 

2.   They are easier to view, as the chart normally takes up the entire 

screen. You can resize a chart on a chart sheet but this isn’t often done. 

3.   They are easier to print, as you can simply click the sheet tab and print. 
You can also print an embedded chart in isolation, but to do so you must 

first find and activate the chart. 

Advantages of embedding charts within worksheets 

1.   You are able to print a chart and worksheet data on the same page. 

If you have no need to print worksheet data alongside your chart, it is better 

to place your charts on chart sheets. 
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INTRODUCTION TO MACROS  

1) Code in Excel is called VBA (Visual Basic for applications) 

 Macro is a synonym for VBA 

 VBA = Visual Basic Application = Macro = written code that executes 

commands to do things(manipulate objects) in Excel. 

2) If you do not know how to write code, you can use the Macro Recorder. 

 When you hit the Record Macro button as seen in the figure below: 

1. It is like a tape recorder 

 2. Whatever you do in Excel, the Macro Recorder writes the VBA Code for 

you. 
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3) Code is good for two reasons: 

1. If you have repetitive tasks that you want to automate (like formatting a 

monthly report). That way you can just click a button and the report is 

formatted 

2. There are some things you want to do (like have a function spell out a 

word), that the commands in the ribbons cannot do. 

4) You must use the ".xlsm" extension in order to use Macros. 

1. File extension: use ".xlsm". "m" means Macro 

2. File extension "xlsx" will not allow Macros. 
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3. In Excel 2003, the file extension .xls works with VBA or without VBA. 

5) To have full access to features for the Macro Recorder, we must show 

Developer Ribbon. 

 Right-click ribbon, Customize Ribbon, check box for Developer tab. 

6) To turn on the Macro Recorder 

 To turn on the Macro Recorder use the "Record Macro button in the Code 

group in the developer Ribbon (or the Record Macro button on the left 

side of the Status Bar). 

 Be sure to Turn off the Macro Recorder when you are done 

7) Relative / Absolute Button: 

 The "Use Relative Reference" button in the Code Group in the Developer 

Ribbon. The "Use Relative Reference" button is a toggle that toggles 

between Absolution and Relative References. When the button is 

yellow/orange in color, the Marco is recording Relative Cell References in 

the Macro. When it is not yellow/orange, it is recording Absolute 

References. 

 Relative Macros record Relative movement of the selected cell (OFFSET 

function). 

 Absolute Macros record absolute movement of the selected cell (RANGE 

function). 

8) Security Level: 

 You must also set the security level in the Code Group in the Developer 

Ribbon to "Disable all Macros with notification"; then each time you open 

the workbook, click the "Options" button that appears when you open the 

workbook, then click "Enable". 

9) Keyboards: 
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 Alt + F11: opens VBA Editor Window so you can write code. 

 Alt + F8: Opens list of macros you can run. 

 "In the VBA editor: 

1. Ctrl + R = "Project Explorer" 

2. F4 = Properties Pane. 

3. Alt, I, M = Insert New Module 

10) Where to store your Macro: 

 If you store Macros in "This workbook", they are only available in this 

workbook 

 If you store Macros in "Personal workbook", they are stored in the hidden 

workbook named "Personal" and the Macros will be available in all 

workbooks on your computer. To edit a Macro in a Personal workbook, 

you must unhide the workbook using the "Unhide" button in the Window 

Group on the View Ribbon. 


